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Overview
Control all of your users of Tapi Link, Call Recorder, and Power Dialer from a central location.
The Managers Console is a simple-to-use yet powerful tool for monitoring, measuring and optimizing your
agents calling processes and patterns. It is ideal for large call centre environments, telesales teams, and
small telemarketing units.
When managing multiple telemarketing campaigns with agents that have different skill sets, the ability
to move and manipulate call queues between agents is fundamental to the efficiency of the team. With the
Managers Console you can start, stop, and switch campaigns, check call quotas and targets, send messages,
view current and historic agent statistics, print call logs, and monitor and manipulate agent activity levels in
real-time.
The Managers Console is the ideal companion to Tapi Link, Call Recorder, and Power Dialer for
GoldMine®.
• Create pre-defined templates tailored to suit specific campaigns
• Display complete call statistics for all agents or individual agents.
• Instantly view the current agent status, who they are talking to, and the calls duration etc.
• View the number of calls completed so far, and the number remaining in the Call Queue.
• Record agent's telephone conversations on demand. (with appropriate licences)
• The Wallboard feature. This displays a ‘league-style’ chart of your teams call statistics which is
constantly updated in real-time - enabling agents to gauge their own individual performance against
other team members.
• Check call quotas and targets, and reorganize agent’s outbound Call Queues to suit.
• Implement automated data-capturing processes for all or any agents.
• Stop and Start Power Dialer campaigns remotely.
• Refocus any agents to a new campaign
• Change individual user, or all users configurations remotely.
• View and print detailed logs of all calls made and received.
• Reporting - convert call logs into dbf format, spreadsheets, or Crystal Reports

®

• Reporting – display a ‘Historic Wallboard’ of call statistics covering specific past periods of time.
• Manipulate agent workloads to match individual skill sets
• Send messages to all agents or any individual agent.
• Manage and manipulate the call-handling processes globally or on an agent-by-agent basis.
• Manage software upgrades/updates and extend or revise user-licences.
All of this happens in real time - so you can rapidly assess the results and adjust agent’s workloads to
meet the changing needs of different call campaigns, staffing levels, or agent skill-sets.
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Pre-requisites and Minimum System Requirements

Pre-requisites
•

The ‘Managers Console’ installation software.
You may have been provided with this software by email or you may have downloaded it directly. The
file name for the installation routine is setup.exe.

•

If using a Windows NT / 2000 / XP / Vista / Windows 7 / 8 / 10 operating system,
you will also require Administrative rights in order to install and configure software.

•

At least one installation of Tapi Link for GoldMine®, Power Dialer for GoldMine®,
or Call Recorder for GoldMine® somewhere on your network.

•

If using the Wallboard feature, you may wish to deploy one or more additional monitor
screens for this particular purpose (possibly of a reasonably large size), in order for all
agents to clearly view their real-time call statistics.

®

®

®

®

®

®

®

Further possible requirements depending on the nature of usage and the working environment are as
follows:
Full access rights for the specific users to their local path:
C:\Program Files\Papillon Technology\Tapi Link [or \Program Files (x86) in 64 bit windows]
Full access rights for the specific users to their local path:
C:\Documents and Settings\ ~ relevant username ~ \Application Data
or C:\Users\ ~ relevant username ~ \AppData
Full access rights for the specific users to the registry section:
HKEY_CURRENT_USER\Software\Papillon Technology\
If applicable, full access rights for the specific users to the registry section:
HKEY_LOCAL_MACHINE\SOFTWARE\Borland\
(Additional configuration and assistance will be necessary if deployed in a Terminal Services environment.
Please contact Papillon Technology for further details.)

System Requirements
•

A networked Windows 98 / NT / 2000 / XP / Vista / Windows 7 / 8 / 10 operating
system with TCP/IP protocol.

•

64Mb RAM and 256 colors (or more) recommended.

•

Approximately 25 Mb of free disk space for the installed program files.

•

Internet Explorer 5.0 or later, (or alternatively; a COM update.)

•

Network client PCs with Tapi Link and/or Power Dialer/ Call Recorder for GoldMine®
installed.

®

®

®

®

®

®

®

®

®
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Starting the installation process

1.
Observe the details covered in the previous sections entitled ‘Pre-requisites’ and ‘Minimum system
requirements’.
2.
Close all programs currently running on the computer.
3.
Double-click on the file named setup.exe.

The installation wizard will prepare to install the software …..

continued . . . .
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Click on the Next button to proceed.

continued. . . .
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If you accept the terms of the licence agreement click on the Next button.

Enter you user name and company name details. Then click on the Next button

continued . . .
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It is recommended that you accept the default location for the destination folder by clicking on the Next
button.

This step of the wizard simply confirms the details you have entered or accepted so far. If you need to revise
any of them click on the Back button. Otherwise click on the Install button.

9

The meter indicates the ongoing progress of the installation.

When the above dialog box appears click on the Finish button to complete the installation.
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Starting the Managers Console for the first time

Start the Managers Console either from the desktop icon or from the Programs menu:

Alternatively, you may launch the Managers Console either from the GoldMine® status bar (see the section
entitled ‘Launching the Managers Console from within GoldMine®’.)
Also you may wish to copy the above shortcut to the windows Startup folder so that the Managers Console
starts automatically when windows launches.
When you first start the Managers Console you may need to adjust the dimensions of the window to suit the
display resolution settings of your particular screen so that none of the elements of the interface are
obscured.
If necessary, this can be achieved by employing standard window frame-resizing methods as follows:
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Position your mouse cursor carefully to point to the
bottom right corner of the window which is serrated.
When the mouse cursor alters to a ‘double
arrowhead’ - click and hold down the mouse button
and then drag the window corner outwards to adjust
it to suit your own screen size and resolution, and
until the lower status bar is revealed as in the next
illustration -

When the console window appears to be fully sized (with the lower status bars clearly visible, and with no
horizontal or vertical scroll bars, as in the above example), proceed to the next section entitled ‘Activating
the Managers Console’.
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Activating the Managers Console
The Managers Console requires either a valid full licence or alternatively a valid evaluation licence in order
to function.
To enter the license details proceed as follows:
From the File menu item select Licensing:

Enter the Activation Key as supplied by Papillon Technology and click on OK.
The software is now activated for use in either fully-licensed or evaluation mode (depending upon how you
acquired the product).
If however, the following message appears –

- contact Papillon Technology using the details provided at the end of this guide in the section entitled
‘Contacting Technical Support’.
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Determining the machines to be managed
In order to use the Managers Console for the first time it will need to know the identities of the particular
machines you wish to monitor.
(This process can also be used when adding additional agent machines at a later date, or perhaps when
substituting alternative machines.)
If you are using an evaluation version of the product, refer instead to the section entitled ‘Alternative
methods of machine identification’.
You can gather the identities of the relevant
machines to your Preferences as follows:

From the File menu select Preferences

1.
Click on the Get
GM Path button.
This will populate
the GoldMine®
Path field above it.
2.
Click on the
Refresh List
button.
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If the following error message appears -

- refer instead to the section entitled ‘Alternative methods of machine identification’.

The list will be populated with the names of the machines upon which Tapi Link/Power Dialer/Call
Recorder for GoldMine® is installed.
(The names shown above are merely examples for illustration purposes. The names of the PCs on your own
network will naturally be quite different.)
Click on the OK button to return to the main interface.

continued . . .
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The main interface of the console can now be populated with the relevant machine information by rightclicking in any field in the DNS Name / IP Address column and selecting Lookup DNS Name.

Choose any field in the left hand column (i.e. by placing the cursor inside the field). Then double-click on
any entries on the list in the right column in order to add them to the left column.

You can add entries to the DNS Name column in any order you wish.
The machine names will alter to GoldMine® usernames when you Start Polling – as detailed in the next
section.
If you would prefer to use other means of identifying the relevant machines – refer to the section entitled
‘Alternative methods of machine identification’ in the Supplementary Configuration section.

(All of the data shown above is simply for illustration. The actual paths and machine names etc. in your own
environment will of course vary considerably.)
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Polling the machines to be managed
Once the relevant computer identities have been entered, click on either the Start Polling button or the File
> Start Polling menu item:

The name of each user currently logged-in will appear, and the butterfly icons adjacent to these will alter to
reflect the current telephone line status of the respective users, as in the following example:

The ability of the icon to reflect the line status is dependent on the specific capabilities and feature set of
each telephone system, therefore some of these visual characteristics may not always be evident with certain
telephone systems.
For an explanation of the icons - refer to the next section entitled ‘Line Status Indicators – Icon Definitions’.
If any icons fail to alter from a butterfly to resemble a telephone – refer to the FAQs and Troubleshooting
sections later in this guide. If you need to monitor more than fifteen machines - see the section entitled
‘Multiple instances of the console’ later in this guide.
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Line Status Indicators - Icon Definitions
The icons reflect the line status/activity at each machine as follows:

Icon

Call Status Indication
No line activity
Call in progress
Incoming call ringing / Outbound unanswered call
Call on hold
Call and recording in progress
Outbound call receiving ‘busy’ signal
Conference call
Transferring call
Conference call & recording in progress
Application not started (or not installed)*

* There are various other possible reasons for this indication e.g. problems with the network protocols,
network segment problems, firewalls, or incorrectly specified computer names, or licence issues etc.
For further information refer to the FAQs and Troubleshooting sections later in this guide.
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The Status Bar
The Status Bar at the foot of the Managers Console is split into two sections:
The upper segment displays details pertaining to ALL agents
The lower segment displays details pertaining only to the selected agent.
The display includes:
•
•
•

The number of agents currently connected.
The line status for the currently selected agent.
Call Statistics for individual agents and all agents

In addition to the icon appearance changing according to the prevailing line status, the Agent Status
indicator alters in real-time to indicate not only the line status but also the ongoing progress of any current
call, as in the following examples:

continued . . .
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Note:
The number of agents connected figure indicates successfully polled agents.
There can be a variety of reasons if the number of agents displayed is different than that expected
e.g. Tapi Link/ Power Dialer may not be installed or not started on some machines, or there may be issues
with network protocols, network segment problems, firewalls, or incorrectly specified computer names etc.
For further information refer to the FAQs and Troubleshooting sections later in this guide.
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Toolbar Icons
The toolbar icons permit a quick alternative method of implementing the Commands menu options (except
those commands relating to All Agents)

A

B

C
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G

H
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K
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Q

R

S

T

U

A simple method to identify the function of any toolbar button is to hover the
mouse icon over the icon, which will reveal the ‘pop-up help’ description.

A

Start Polling

B

Stop Polling

C

Find Current Contact Record

D

Get Current Telephone Number

E

Display Agent Call Log

F

Retrieve Simple Call Stats

G

Retrieve and Modify Agents Settings

H

I

Send Config File to Agent

Create Agent Config File from Agent

J

Manually Change Agent Settings

K

Auto Top-Up to Call List

L

M

N

O

P

Q

R

S

T

U

Acquire New Call List

Start Power Dialer

Stop Power Dialer

Hang Up Call

Start Recording Call

Stop Recording Call

Send Message

Force Agent to Exit

Get Version

Dump Application Log
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Column Headers - definitions
The data displayed in the various Managers Console columns is as follows:

Indicates the application
running on the PC.
(see * Client Type below)

The name of the currently
logged in GoldMine® user.

Indicates the party on the line
and whether the call is incoming
or outgoing.

The status of the telephone line.
(see the section Line Status
Indicators – Icon Definitions.)

The current call duration, and the
total calls handled. **

The total calls in the agents
queue and the incremental call
number in progress/completed.

* Client Type

A client machine with Power Dialer for GoldMine®.

A client machine with Power Dialer for GoldMine®.in active session.

A client machine with Tapi Link for GoldMine®.

**
The Call Count will indicate all attempted calls, regardless of whether successfully connected or not.
Therefore this will take account of calls that were abandoned due to no answer, and for example, also calls
that were abandoned perhaps in order to accept an inbound call instead. Refer to the individual agents call
statistics on the status bar at the foot of the Managers Console for an exact record of successfully completed
calls.
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Preferences

To configure specific operational
parameters for the Managers Console –

select Preferences from the File menu –

This will summon the Preferences dialog box –
Choose to establish connection to available agents
immediately upon launching the Managers
Console, rather than manually.

Choose to automatically refresh statistics on the
Status bar rather than updating them manually.
This means that there will be no ‘static snapshots’
of any given moment available, because the
statistics will be continually revised in real-time.

In the event of loss of connection to agents, or
when experiencing difficulty establishing an
initial connection, this option will enable reconnection attempts to be made automatically

continued . . .
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The list of available agent machine names can be populated as follows:

1.
Click on the Get GM Path
button. (This will populate the
GoldMine Path field.)

2.
Click on the Refresh List button.

3.
This column will be populated with
the names of the machines upon
which Tapi Link/Power Dialer/Call
Recorder for GoldMine® is installed.

This enables you to easily configure the main interface of the console with the relevant machine information
in the DNS Name / IP Address fields. (Right-click in the fields and select Lookup DNS Name.)

(All of the data shown above is simply an example. The actual paths and machine names etc. in your own
environment will vary considerably.)
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Selecting an Agent
Before any commands can be issued to an individual agent, the relevant agent must be selected.
If you have not selected an agent the following error message will appear:

To select an individual agent to monitor or manage simply click on the radio button adjacent to the required
agent name:

Having done so, any of the commands you subsequently apply will relate solely to that individual agent.
Alternatively, you may use the All Agents commands shown below, which affect all agents managed by
this particular instance of the Managers Console.
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Accessing the commands
Facilities to manage individual agents can be accessed from the toolbar icons, a context-menu, or the
Commands menu as follows:

When executed, the commands apply to a single selected agent.
However, the commands within the All Agents menu option apply to ALL users managed by that instance
of the Managers Console.
Agents managed by one instance of the Managers Console are independent of, and unaffected by,
commands deployed at another, separate instance of the Managers Console – unless the other instance also
monitors the same agent(s).

continued . . .
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The commands can also be accessed from a convenient context menu.
This option permits a clearer view of the list of agents and call details, and in particular – the selected agent.

To access the context-menu, right-click almost anywhere on the console interface:

The context-sensitive commands relate only to the individually selected agent – NOT to multiple agents.
(To deal with multiple machines use the All Agents command option which is only available from the
Commands menu item.)
The use and effect of each separate command is explained in the following sections.
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Find Current Contact Record
This command will raise, within your own local copy of GoldMine®, the same record of the contact with
whom your agent is currently conducting a call.
In the Managers Console select the agent required.
From the toolbar icons select
Record.

or in the Commands or context menu select Find Current Contact

The current contact record appearing in GoldMine® at the Mangers Console machine will alter to match the
one with whom the agent is currently conducting a call –

Of course for this feature to function, GoldMine® must be running on the machine at which you are using the
Managers Console.
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Get Current Telephone Number
This command enables you to identify the telephone number of the current call in progress with the chosen
agent. This does not necessarily need to be a number that is held in GoldMine®.
Via the Managers Console - select the agent required.
From the toolbar icon
Number:

, the Commands menu, or context menu select Get Current Telephone

The relevant telephone number will be displayed as in the following example:
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Display Agent Call Log
This command displays a log of the selected agent’s inbound and outbound calls.
Select the agent you wish to monitor in the Managers Console.
From the toolbar icon

, the Commands menu, or the context menu select Display Agent Call Log:

This will raise the call log within the Managers Console interface itself, as in the following example:

Right-click within the call logging box to reveal further options as follows -
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To CLOSE the agent calls log

- Simply double-click anywhere within the call log window, or
right-click and select Close from the context menu.

To PRINT the agent calls log

-

Right-click in the text area and select Print
from the context menu –

Or select Print from the File menu

To SAVE the agent calls log - right-click and select Save to File from the context menu.
If you select Save to File the following dialog box will appear:
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The default file name is GMAGENT.LOG but this can be changed if required.
Select the location and the desired name for the logfile and click on the Save button.
(See the Note on the following page if a different dialog box appears.)

This file can be opened in Notepad or any word-processing application.
®
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If your operating system is not configured to display file extensions (such as GMAGENT.”LOG”) simply
locate the file named ‘GMAGENT’. This file, by default, is depicted with a Notepad® icon.
(If you wish you can alter this option via windows Control Panel > Folder Options and choose to display
file extensions.)
Note
If a previously created file with the same name exists in the same location – the following prompt will
appear asking whether you wish to overwrite it with this later example:

Select Yes to overwrite the existing file.
Alternatively, choose No to cancel the process if you wish to move the original to a safe place or to rename
the original and avoid it being overwritten.
This file format can be converted for use in other applications if necessary – see the Tools Menu section
entitled ‘Convert External Call Logging File to DBF’.
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Retrieve Simple Call Stats
This command will provide basic call-related statistics for any selected agent.
Select the agent you wish to monitor within the Managers Console.
From the toolbar icon

the context menu, or the Commands menu, select Retrieve Simple Call Stats:

The information dialog box will show the relevant statistics for the specific agent:
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All Agents > Retrieve All Agent Call Stats
This option enables you to view statistical totals in respect of ALL agents.
From the Commands menu select All Agents and Retrieve All Agent Call Stats from the sub-menu:

This will populate the upper segment of the status bar with statistics for all agents.
(The lower segment relates to single selected agents.)
BEFORE

AFTER

Note that this is a static ‘snapshot’ of the statistics taken at that particular moment. (AutoRefresh is OFF)
The time that the last snapshot was taken is also indicated in the above example.

continued . . . .
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Clicking on the Auto Refresh button will switch on automatic refreshing of the statistical data.
This will update every 60 seconds.

The time that the data was last refreshed is displayed.
(Simply click the Auto Refresh button again to toggle this facility off if not required.)

Individual categories of the statistics shown are as follows:
Answered:
This refers to calls that are actually connected.
Note that the Call Count shown in the main console interface is the total of attempted rather than connected
calls. The Answered calls statistics details calls that were actually connected. Calls to busy lines and bad
numbers are considered to be unanswered calls, as are inbound calls which have gone to voicemail.
Average:
This is the average time consumed on connected (i.e. answered) calls.
[It does not include time waiting for a call to be answered etc.]
Incoming:
The number of answered calls set against the total incoming calls. (Answered / Total)
Outgoing:
The number of answered calls set against the total outgoing calls. (Answered / Total)

(Commands pertaining to ALL agents apply to all agents monitored by this particular instance of the
Managers Console, and do not apply to different agents monitored by other instances of the Managers
Console which may be in use on the network.)
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Retrieve and Modify Agent Settings
This command will permit you to remotely view a representation of the agent’s setup dialog box - a similar
visual interface to one you would see from their perspective, i.e. as if you were configuring the Tapi Link /
Power Dialer / Call Recorder directly from their own PC. This enables you to implement or revise a wide
range of agent-specific settings.
Some of the agent’s Setup tabs will not be visible since they are largely irrelevant for management purposes
– they are TAPI, PD Call Queue, and Call Logging, However, this remote view from the Managers Console
features an extra Speed Buttons tab and also additional supervisory features within the Advanced tab.
Select the agent whose configuration you wish to observe or revise within the Managers Console –

From the Commands menu, toolbar icon
or
context menu, select Retrieve and Modify Agent
Settings:

The Setup Agent Configuration interface will appear, displacing the original view of the Managers
Console.
The title bar of the interface indicates the name of the selected agent and the identity of the chosen machine
-
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While many functions and commands are available from the Command and Tools menu of the Managers
Console, it is possible to view and modify an even wider variety of settings via this ‘agents perspective’ of
their Setup Agent Configuration dialog box
For example, you may change agents call campaigns, update the licensing details, modify screen-popping
settings and the type of data which is displayed, switch telephone scripts, alter the call handling and call
recording features, implement security restrictions, and manipulate call completion processes.
The various options available on each tab are comprehensively detailed in the respective user guides for
each application the agents are using e.g.. Tapi Link, Power Dialer, and Call Recorder for GoldMine®.
Whilst the individual agent Setup Agent Configuration dialog box is active it displaces the view of the
Managers Console.

To save any changes made to the agents configuration click on the Apply button.
This will return you to the original Managers Console interface.
To exit the dialog box and return to the Managers Console without saving any changes - click on the Cancel
button.
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Auto Top-Up to Call List
This command is only applicable to agents using Power Dialer for GoldMine®
Power Dialer can automatically allocate a pre-determined number of calls to a user when a specific ‘low
threshold’ of calls is reached in their Call List. (Comprehensive details of this feature are available in the
‘Power Dialer Installation & Configuration Guide’.)
This feature may already be set to ‘automatic’ for one or more of the agents (i.e. if the Auto Top-Up to Call
List option on the Advanced tab and Re-Acquire List and Start Dialer at End of Queue on the PD
Dialing tab are checked). However, if you wish to invoke this feature for them manually, proceed as
follows:
From the Managers Console select the individual agent.
From the toolbar icon

, the Commands menu, or context menu –

select Auto Top-Up to Call List

The animated dialog box provides details of the number of calls added to the individual agents Call List:

(This figure corresponds to the quantity specified in the individual agent’s configuration settings i.e. the PD
List Auto Top-Up Options on the Advanced tab. The above dialog box will not appear unless these
options are enabled )
If necessary, click on the Stop button if you wish to halt the process.
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Acquire New Call List
This command is only applicable to users of Power Dialer for GoldMine® and will proceed to load a new
Call List for the selected agent.
Select the agent required from the Managers Console.

From the tool bar icon
the context
menu, or the Commands menu, select
Acquire New Call List:

An animated dialog box will appear indicating the ongoing call acquisition, as in the following example:

Remember that this process is subject to the prevailing call acquisition criteria as specified on the agents PD
List Acquisition tab. If these parameters require any adjustment, this can be achieved via the Managers
Console [see the section entitled ‘Retrieve and Modify Agents Settings’] or by the agent themselves,
directly on their own machine.
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Start and Stop Power Dialer
There are two separate menu commands and toolbar icons to Start and Stop Power Dialer:
Rather than having a single button that toggles between Start and Stop, the Managers Console has both of
the options visible simultaneously so that you have the option to start Power Dialer for some users whilst
stopping it for others. i.e. the current activity status (i.e. started or stopped) can vary from agent to agent and
so the context of the available command varies accordingly.

Select the chosen agent in the Managers Console then either:

Start Power Dialer
This command will commence the power-dialing sequence for the selected agent.

Stop Power Dialer
This command will stop the power-dialing sequence for the selected agent, but will NOT terminate any
current ongoing call or any associated Power Dialer process for that specific call.
It will however, prevent the next call and any further calls in their Call Queue from being made - until such
time as Start is selected either at the Managers Console or locally by the user(s) themselves.
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Stop Power Dialer for All Agents
To stop Power Dialer for all agents –
Select All Agents > Stop Power Dialer for All Agents.

This command will stop the power-dialing sequence from moving forward for all agents with Power Dialer
actively on calls.
It will NOT terminate any current ongoing calls or any associated Power Dialer process for those specific
calls.
It will, however, prevent the next calls in their Call Queues from being made (until Start Power Dialer is
selected - either at this console, or locally by the user(s).
You may wish to message to alert the users before deploying this particular command.
If so, see the section entitled All Agents > Send message to All Agents for further details..
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Hang Up Call
This command will terminate the current call for the selected agent.
Select the chosen agent in the Managers Console.

Select Hang Up Call from the Commands menu, context menu, or the toolbar icon

If this event is unanticipated by the agent, you might also choose to send a warning message to the agent(s)
before proceeding - as detailed in the section entitled ‘Send Message’.
NOTE
This command will only terminate the current call in progress.
It does not halt the progress of subsequent calls.
i.e.
If used in relation to a Power Dialer user, this does not prevent the ongoing Power Dialing sequence.
All of the associated process which have been pre-selected to occur in the Power Dialer / Call Recorder
configuration settings will still occur, for example –
The next Power Dialer call, linked Call Recordings, prompts For Linked Call Recording References,
prompts For Linked Call Recording Notes, Schedule Follow Up Call dialog boxes, and corresponding
History entries for recorded calls.
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Start Recording Call
(Call Recording is an optional extra and not part of the default functionality of Tapi Link / Power Dialer for
GoldMine®. Please contact Papillon Technology if you require further details of this feature.)
The Call Recording feature allows GoldMine® users to record any individual calls on demand, record every
call automatically, or record a pre-determined percentage of calls at random.
The recorded calls are automatically attached to the relevant clients GoldMine® record via the Links tab,
thereby ensuring you have a complete and accurate record of your telephone conversations immediately to
hand. Recorded calls can be replayed from any standard multimedia-equipped computer. (Neither
GoldMine®, Tapi Link for GoldMine®, nor the Call Recorder hardware or software is required for playback
purposes.)
In addition to the ability of replaying of calls from the Links tab, you may also replay them directly by
browsing to the designated storage location (e.g. via Explorer). This means that you can sort and sift
through calls by other criteria, for example by agent, or by date etc.
If the relevant agent machine includes an installation of Call Recorder for GoldMine® this command
provides the option to commence recording the current call.
Select the chosen agent in the Managers Console.

From the tool bar icon
the context menu, or the
Commands menu, select Start Recording Call:

The recording process will stop when the call is terminated, unless overridden by the Stop Recording Call
command.
The recording and saving/linking process remains subject to whatever settings are currently specified on the
individual agents Call Recording tab. So for example, if the agents recording configuration is not set to
‘Automatic’ then the process will need to be stopped manually by the Managers Console command or by
the user locally.
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Stop Recording Call
(Call Recording is an optional extra and not part of the default functionality of Tapi Link / Power Dialer for
GoldMine®. Please contact Papillon Technology if you require further details of this feature.)
The Call Recording feature allows GoldMine® users to record any individual calls on demand, record every
call automatically, or record a pre-determined percentage of calls at random.
The recorded calls can be automatically attached to the relevant clients GoldMine® record via the Links tab,
thereby ensuring you have a complete and accurate record of your telephone conversations immediately to
hand. Recorded calls can be replayed from any standard multimedia-equipped computer. (Neither
GoldMine®, Tapi Link for GoldMine®, nor the Call Recorder hardware or software is required for playback
purposes.)
In addition to the ability of replaying of calls from the Links tab, you may also replay them directly by
browsing to the designated storage location (e.g. via Explorer). This means that you can sort and sift
through calls by other criteria, for example by agent, or by date etc.
If the relevant agent machine includes an installation of Call Recorder for GoldMine® this command
provides the option to terminate recording of the current call.
Select the chosen agent in the Managers Console.

From the Commands menu, toolbar icon
or
the context menu - select Stop Recording Call:

The recording and saving/linking process remains subject to whatever settings are currently specified on the
individual agents Call Recording tab. ‘Stop Recording’ is the equivalent of ‘Save Recording’ – and not
‘abandon the recording’.
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Send Message
This option enables you to send a text-based message directly to any agent.
In the Managers Console select the agent you wish to message.
Select Send Message via the toolbar icon

context menu, or Commands menu:

The text message box will be displayed:

Enter your desired message and click on the OK button.

continued . . .
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From the agents perspective the message would appear as follows -.

The following illustration provides a general visual guideline to the maximum amount of text that can be
sent in any single transmission. (Approximately 250 characters.)

You may use the regular cut/copy and paste techniques to apply pre-prepared text or send standard
messages to agents
You may also send consecutive messages.
If, upon receipt, these messages are not individually acknowledged by the appropriate agent – they will
accumulate as in the following example:

… they will need to be dismissed in the order of most recent first, as access to the preceding messages is
denied until the latest messages are attended to.
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All Agents > Send Message to All Agents
(Commands which affect ALL agents simultaneously are only available directly from the Commands menu
– not from the context menu or toolbar icons.)
This option enables you to send a text-based message directly to ALL agents.
From the Commands menu select All Agents and Send Message to All Agents from the sub-menu:

Enter the required message and click on the OK button to transmit, or Cancel to abandon

In this example, the text above would be sent to all users.
(Refer to the section entitled ‘Send Message’ for further details of this particular command.)

Bear in mind that commands pertaining to ALL agents apply only to all agents monitored by this particular
instance of the Managers Console, and not different agents monitored by other instances of the Mangers
Console which may be in use elsewhere on the network.
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Force Agent to Exit
This command will close down Tapi Link / Power Dialer / Call Recorder for GoldMine® on the chosen
agent’s machine. If a subsequent restart is required this will need to be instigated from the relevant agents
machine itself. (Before executing this command you may wish to send a message to the appropriate agent as detailed in the section entitled ‘Send Message’.)

To proceed, first select the relevant agent then -

From the toolbar icon
, the context menu, or the
Commands menu, select Force Agent to Exit:

The telephone status indicator on the Managers Console will alter to display the following icon, indicating
that Tapi Link or Power Dialer is no longer in service -

- and the corresponding icon will disappear from the agents own system tray on the relevant machine.

The current call will not be terminated, nor will the manual dialing/receiving of calls be affected. *
However, Tapi Link / Power Dialer / Call Recorder for GoldMine® processes that were setup to handle that
call to its normal conclusion (e.g. displaying a call completion dialog box at end of the call, creating and
linking of call recordings etc.) will no longer occur. For example, an unfinished Call Completion dialog box
which has not yet been finalised by clicking on the OK button will also be summarily terminated.
Tapi Link / Power Dialer / Call Recorder for GoldMine® will need to be restarted at the relevant machine in
order to restore functionality.

* Except in some isolated circumstances, for example when using certain telephone systems such as Nitsuko® or Swyx®. Should you
choose to use this command it might be wise to test and establish in advance exactly how your particular telephone system responds.
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All Agents > Force All Agents to Exit
This command will close down Tapi Link / Power Dialer / Call Recorder for GoldMine® on ALL agents
machines displayed on this particular instance of the Managers Console.
From the Commands menu select All Agents and Force All Agents to Exit from the sub-menu:

(Before executing this command you may wish to send appropriate warning messages to the agents - as
detailed in the section entitled ‘Send Message to All Agents’.)
The telephone status indicators on the Managers Console will alter to display the following icons, indicating
that the relevant application is no longer in service –

- and the corresponding icons will disappear from all agents system trays on the relevant machines……

Current calls will not be terminated, nor will the manual dialing/receiving of calls be affected.*
However, Tapi Link / Power Dialer / Call Recorder for GoldMine® processes that were setup to handle that
call to its normal conclusion (e.g. displaying a call completion dialog box at end of the call, creating and
linking of call recordings etc.) will no longer occur. For example, unfinished Call Completion dialog boxes
which have not yet been finalised by clicking on the OK button will also be summarily terminated.
To restore the functionality of these applications to the agents, Tapi Link / Power Dialer / Call Recorder for
GoldMine® would need to re-launched at each relevant machine.
Bear in mind that commands pertaining to ALL agents apply to all agents monitored by this particular
instance of the Managers Console, and not to different agents monitored by any other instances of the
Managers Console which may be in use elsewhere on the network.

* Except in some isolated circumstances, for example when using certain telephone systems such as Nitsuko® or Swyx®. Should you
choose to use this command it might be wise to test and establish in advance exactly how your particular telephone system responds.
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Manually Change Agent Settings
This command is very powerful and requires an understanding of the nature and structure of initialization
files. Use of this command is not recommended unless you have the appropriate technical knowledge.
The simpler and safer alternative to this particular option is to use the command Retrieve and Modify
Agents Settings which provides a more straightforward graphical interface to agent’s settings - instead of
the more complex text-based command instructions which follow.
Each individual agent’s configuration is usually stored within a file called GMTAPI5.INI which is located
within the Tapi Link/Power Dialer installation directory. It is this specific file which is modified when using
this particular method of altering agents settings. (Alternatively, in a Terminal Services environment, the
user registry settings are modified.)
If you wish to proceed, in the Managers Console select the specific agent whose settings you wish to
configure.
Select Manually Change Agent Settings from the toolbar icon
or Manually Change Settings from the agent context-menu

, Commands menu,

For the purposes of illustration this example assumes a scenario in which you wish to disable the inbound
call screen-popping feature for a particular agent who may need to focus purely on outbound calling.

continued . . .
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A dialog box will appear which requests the name of the section within the initialization file, within which
the particular attribute you wish to alter is located:
(See the list of section names which follow this example )

Enter the name of the appropriate section (case is immaterial) as in the example above, and click on OK.
This will raise a further dialog box requesting the particular item within the section that you wish to revise:

Enter the relevant item name and click on OK.
(In this particular instance the item name is the same as the section name.)
This will raise a further dialog box requesting the particular value for that item that you wish to revise:

Enter the new value and click on OK.
In this particular example, screen-popping functionality for inbound calls will now have been disabled on
the relevant agent’s machine.

continued . . .
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To illustrate the effect of this process, from the individual agents’ perspective, the Screen Pop GoldMine®
option on the Calls In tab will have been de-selected as follows, and screen-popping functionality deactivated:

The individual section names within the initialization file (or registry) are as follows:
TAPI

FIELDS

SETUP

DIALSETTINGS

KEYPAD

KEYPAD1

ACQUISITION

CALLRECORD

KEYPAD2

CODES

SEARCH

KEYPAD3

LICENCE

POPUP

SPEEDDIALS

GOLDMINE

DISPLAY

The actual entries within the sections (as opposed to the section labels) are too numerous to mention here,
but further information can be gleaned from examination of the file named GMTAPI5.INI which is located
in the Tapi Link directory (normally C:\Program Files. . . .\Papillon Technology\Tapi Link by default). If
you are unfamiliar with this type of procedure it might be advisable to make a backup copy of the original
file(s) before proceeding with this operation.
Please contact Papillon Technology if you require further details.
You may also change the setting for ALL agents at once.
To do so – see the section entitled ‘All Agents > Manually Change All Agent Settings’.
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All Agents > Manually Change All Agent Settings
This command is very powerful and requires an understanding of the nature and structure of initialization
files. Use of this command is not recommended unless you have the appropriate technical knowledge.
The simpler and safer alternative to this particular option is to use the command Retrieve and Modify
Agents Settings which provides a more straightforward graphical interface to agent’s settings - instead of
the more complex text-based command instructions which follow.
However, the Retrieve and Modify Agents Settings command will only permit changes to be made to
ONE machine/agent at a time; whereas the settings created or revised by this command will affect ALL
agents.
Each individual agent’s configuration is usually stored within a file called GMTAPI5.INI which is located
within the Tapi Link/Power Dialer installation directory. It is this specific file which is modified when using
this particular method of altering agents settings. (Alternatively, in a Terminal Services environment, the
user registry settings are modified.)

Amongst many other examples, (for all agents monitored by that instance of the Managers Console)
this command would enable you to:










Enable/disable elements within the software
Modify screen-popping features.
Alter Keypad settings and Speed Dial settings
Alter Call Completion dialog box elements.
Modify Call Recording and Power Dialer settings.
Modify Call List acquisition criteria
Setup and modify security settings
Update or modify the licensing information
Activate newly-licensed elements within the software

Refer to the information provided in the preceding section entitled ‘Manually Change Agents Settings’ for
more detailed information.
Bear in mind that commands pertaining to ALL agents apply only to all agents monitored by this particular
instance of the Managers Console and not to different agents monitored by any other instances of the
Managers Console which may be in use elsewhere on the network.
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Get Version
It is advisable to ensure that you have exactly the same version of Tapi Link for GoldMine®, Power Dialer
for GoldMine®, and/or Call Recorder for GoldMine® installed on all users’ machines.
If all versions are not identical then you may experience a difference in the available feature set or
functionality between certain machines.
This command will enable you to establish the current version of the above-mentioned software currently in
use at each agent’s machine.
This information will also prove useful if the need arises to contact Technical Support.
From the context menu or the Commands menu, select the agent machine you wish to check.

From the Commands menu,
toolbar icon

or context menu

select Get Version

The version number will be displayed when the mouse cursor is hovered over the name of the selected agent
as in the following example:

To obtain version numbers for all agents - see the next section entitled ‘All Agents > Get All Versions’.
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All Agents > Get All Versions
It is advisable to ensure that you have exactly the same version of Tapi Link for GoldMine®, Power Dialer
for GoldMine®, and/or Call Recorder for GoldMine® installed on all users’ machines.
If all versions are not identical then you may experience a difference in the available feature set or
functionality between certain machines.
This command will enable you to establish the current version of the above-mentioned software currently in
use at every agent’s machine.
This information will also prove useful if the need arises to contact Technical Support.
From the Commands menu select All Agents and then Get All Versions -

Unlike the individual agent Get Version command, it is not necessary to select any individual agents.

Simply hover the cursor over any of the agents in order to view the version information – regardless of
where the radio button is selected.
If using the Auto Refresh option this particular feature will be enabled automatically and it is not necessary
to select All Agents > Get All Versions.
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Dump Application Log
This command will generate a log file detailing the ongoing events and processes of Tapi Link / Power
Dialer / Call Recorder for GoldMine®. An Application Log can prove to be useful to check user log-ins,
licensing issues, call list acquisition and screen-popping matters and for specific trouble-shooting purposes.
In addition, this file is almost always required if the need arises to contact Technical Support.

or the
From the context menu, toolbar icon
Commands menu, select the machine for which
you wish to create an Application Log.

Select Dump Application Log:

This will create an Application Log on the chosen agent’s machine.

The file is named ‘GMTAPI.LOG’ and by default is located in the users \Application Data or
\AppData\Roaming\ directory on the appropriate agent’s machine.
This file can be opened in Notepad or any word-processing application. If your operating system is not configured to display file
extensions you can alter this option via Control Panel | Folder Options | and then choose to display file extensions.
®
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Programming the Agent’s Speed Buttons
This section is divided into three elements:-

1. OVERVIEW – the functionality and benefits of Speed Buttons.
2. IMPLEMENTATION – how to setup and configure Speed Buttons
3. RESULTS – an example of the results that can be achieved using Speed Buttons.

1. OVERVIEW
Whether the result of each call is considered successful or otherwise, the rapid completion and efficient
annotation of the outcome of the call in GoldMine® is very important - and the quicker this is completed the
sooner the next call or activity can be undertaken.
This is especially significant in terms of Power Dialer, where the objective is to move rapidly forward
through the outbound Calls List. However, the following principles can be applied just as effectively to Tapi
Link users who may be accepting incoming calls as well as making outbound calls.
Programmable Speed Buttons save time, avoid input errors, and minimize keystrokes by automatically
populating Result Codes & References and rapidly completing and closing the inbound/outbound Call
Completion dialog boxes.
Clicking on one of the Speed Buttons will instantly complete and close the dialog box. The GoldMine®
History tab will be populated with the completed call entry - including the chosen Result Code and the
designated Reference (or the original, depending on your choice).
It is also possible for this feature to automatically schedule follow-up calls or other activities to occur after
the elapse of pre-determined time intervals, with specific Reference and Activity Codes, and to assign those
activities to specific users.
This feature can be activated and configured either from the agent’s perspective or implemented via the
Managers Console.
(The configuration method from the agent’s perspective, i.e. directly from the agent’s machine, is detailed in
both the Tapi Link and Power Dialer for GoldMine® Configuration Guides.)
This section will concentrate solely on the configuration of agents Speed Button settings on a remote basis
from the Managers Console.

continued . . . .
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The standard incoming and outgoing Call Completion dialog boxes appear as follows:

(Whether ‘incoming’ or ‘outgoing’, the dialog box varies only in the name appearing on the title bar.)
However, with this feature enabled 10 programmable Speed Buttons will appear as follows:

(The above example shows an incoming call dialog box. However, the same principle applies to both
incoming and outgoing call completion boxes.)
The actual button labels are entirely your own choice. Those shown above are merely examples.
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Clicking on one of the Speed Buttons will 9
9
9
9

Instantly complete and close the dialog box.
Populate the GoldMine® History tab with the completed call entry including - the chosen Result Code (as depicted on the Speed Button).
- the chosen Reference (or the original depending on your choice).

and also, will optionally –
9
9
9
9
9
9

Schedule a follow-up call (or another activity) which is automatically configured to be made ….after a pre-determined time interval.
….by a specific user.
….with a specific Activity Code.
….with a specific Reference.
And, depending on the agent’s software settings, it will also trigger the next call in the queue.

2. IMPLEMENTATION
To implement the programmable speed buttons feature, proceed as follows:
In the Managers Console select the agent for whom you wish to implement Speed Buttons.
(If you wish to provide all agents with uniform settings – also refer to the sections entitled
‘Create Agent Config File’ and ‘Send Config File To All Agents’.)

From the toolbar icon
the Commands menu,
or context menu select Retrieve and Modify
Agent Settings:

continued . . .
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On the Setup Agent Configuration dialog box select the Dialog Boxes tab:

Check Show Complete Call Speed Buttons

This will introduce Speed Buttons to the call completion boxes of the chosen agent(s). To configure the
attributes of the agents Speed Buttons - select the Speed Buttons tab in the Setup Agent Configuration
interface:

Speed Button 1

Speed Button 10

Each of the 10 rows in this interface corresponds to one of the ten individual Speed Buttons.
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The objective is to setup the events that you wish to occur and also the information that you wish to be
recorded in GoldMine® when a Speed Button is clicked.
The left hand side of the interface
stores information relating to the
completion of the current call.

CURRENT ACTIVITY

The right hand side holds information relating to any
follow up call or other type of activity that you wish
to have scheduled – either manually or automatically.

SUBSEQUENT ACTIVITY

The following criteria, specific to each button, can be entered in the appropriate columns:
CURRENT ACTIVITY
Reference
A subject or title identifying the call which will subsequently appear on the History tab of GoldMine®.
Activity Code
A code indicating the nature of the activity.
Result Code
A code indicating the outcome of the call which will appear on the History tab of GoldMine®. This will also
appear on the Speed Button itself.
Hide
Conceals the individual button on the user interface. This allows the individual removal or re-introduction
of any Speed Buttons to suit specific campaigns or agent skill sets.
continued . . .
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SUBSEQUENT ACTIVITY
Schedule Activity
Check this option to manually schedule a follow up call or another type of activity..
Auto Schedule
Check this option to access the additional automated scheduling options:

Time/Offset
Depending on the result of previous calls, you may wish to configure Tapi Link/Power Dialer to schedule
further follow up calls/activities - and you may also prefer to have these follow up calls/activities made only
after a specific period of time has elapsed.
(Calls with results of busy numbers, calls which are unanswered, and calls to answering machines/voicemail are dealt with elsewhere
i.e. via options on the PD Auto Completion tab. This particular aspect is dealt with comprehensively in the separate document for
Power Dialer entitled ‘Power Dialer Installation & Configuration Guide’.)

In order to do so, proceed as follows:
Enter the period that you want to elapse before the next call/activity is due.
The format for the Time Offset is either:
Absolute Time
hh:mm. (e.g. 13:30 would signify a re-scheduled call at half past one.)
or
Relative Time
any value from 1 up to 144 [where each unit equals a period of 10 minutes]
(e.g. an entry of 36 would signify a re-scheduled call in 6 hours time.)
For example, an afternoon call completed at 4.00 pm could have an associated activity scheduled for the
following morning at 10.00am. In this case you could enter either 10:00 or 108 in the respective fields
above. (If using relative time, a simple ‘rule of thumb’ would be to remember that 144 is the equivalent of
one full day [24 hours] ahead.)
Alternatively, you can use the following format:
09:30 +1
which signifies 9.30 am tomorrow. (i.e. 9.30 plus 1 day forward)
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User for Scheduled Activity
If you wish the scheduled activity to be booked to another user rather than the current user – enter the
username.
Reference for Scheduled Activity
The subject or title – usually describing the purpose of the scheduled call or activity
Activity Type
Enter either C N A or O
C = Call N = Next Action A = Appointment O = Other Action
(Any other entries will be ignored.)
Activity Code
Enter a code to identify the type of scheduled call or activity (e.g. CC2 which might indicate a 2nd Cold
Call).

The following example illustrates the type of entries that might be used:

The results of using the highlighted entry above are shown in the following example -

continued . . .

64

3. RESULTS
Based upon the above example, the corresponding agent’s incoming/outgoing Call Completion boxes would
appear with the Speed Buttons, as follows:
(Note that in this instance the first and last Speed Buttons are hidden, as specified in the configuration.)

From the perspective of an agent taking a verbal order by telephone, the results of the above example are as
follows –
Simply clicking on the VOR button above will automatically -

¾ Populate the Result Code field with the entry VOR
¾ Populate the Reference field with the entry ‘Get Order’
¾ Populate the Activity Code with the entry ‘GPQ’
¾ Close the dialog box
¾ Create a History entry in GoldMine bearing the details above.
®

¾ Schedule a follow up Call to another user named SUZY, with a Reference of ‘Process
Payment’ and an Activity Code of PRP, to be made forty minutes later.

¾ Make the next call in the Call List i.e. if Power Dialer is being used

(and that the OK/Cancel buttons Hang Up the Call option is checked within the agents Setup
configuration – via the PD Dialog Boxes tab.)
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Updating GoldMine Fields Automatically
®

In addition to the usual call completion and re-scheduling functions of the Speed Buttons, each Speed
Button can also be programmed to automatically update up to 2 different fields in GoldMine®.
The designated GoldMine® fields will be populated with whatever data you have specified on the Speed
Buttons tab within the Managers Console.
This particular feature is not available via the agents’ own local interface. It can only be implemented and
configured via the Managers Console.
This is a powerful feature and therefore it should be used with caution.
It is designed to replace/update/overwrite existing data.
Ensure you read the instructions carefully and configure the available options correctly.
To implement the ‘Field Update’ Speed Button feature, proceed as follows:
In the Managers Console select the relevant agent.
(If you wish to provide all agents with uniform settings – also refer to the sections entitled ‘Create Agent
Config File’ and ‘Send Config File To All Agents’.)

From the toolbar icon
the Commands menu,
or context menu select Retrieve and Modify
Agent Settings:

continued . . . .
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Select the Speed Buttons tab:

Button 1

Button 10

Each row (1 – 10) in the console interface corresponds to one of the ten individual
Speed Buttons on the Call Completion Dialog Box:

Button 1

Button 10

If you wish, you may choose to update only one field for any particular button, rather than two fields.
You may also leave any button completely unassigned.
However, note that if a valid field remains in any of the two Field To Update columns – but the Update 1
or Update 2 Values are blank or empty this is not the equivalent of leaving the update function disabled.
The effect of using a Speed Button configured in this manner would be to delete any existing data from the
relevant GoldMine® field (i.e. it will update the field with the data you have specified. And in this case, that
information is – no data).
continued . . .
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Enter the true name of the GoldMine® fields which you wish to be updated

Enter the new data in the format that you wish it to appear in the designated field.

Based upon the example settings above, when clicking upon Speed Button 1, in addition to whatever else
may have been pre-programmed to the button, the relevant GoldMine® fields would also be populated or
updated as shown in the example below –

NOTE
The programming of the particular Speed Button concerned must include the re-scheduling of a call (or
other activity) in order for this ‘Field Update’ process to occur. So for example if you were to consider
updating a field to read ‘Not A Prospect’ it is therefore unlikely that you would be re-scheduling any more
calls to that contact. Therefore, if you are not re-scheduling any call, and you still want the field update to
function correctly, you may wish to consider programming a scheduled ‘Next Action’ to another user – in
order for them to delete or otherwise attend to the relevant contact record(s) of this type.
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Display Wallboard
Call statistics can be gleaned from within the Managers Console itself, or by the individual agent from their
own Tapi Link/ Power Dialer interface. In addition, the Managers Console provides the Wallboard feature.
This is a distinct and separate visual display designed specifically for agents to observe their entire team’s
statistics as a whole, and compare their own individual progress and performance against other members of
their team – and so promoting a healthy competitive spirit to the proceedings.
Ideally, the Wallboard would be launched on a separate PC (or PCs) which is specifically devoted to this
particular display – perhaps a PC with a large monitor, or a screen projector. The PC(s) could still be used
for other purposes as well if necessary. However, if there are security matters to take into consideration, you
may wish to remove the mouse and keyboard from the machine in order to avoid any unwarranted userintervention.
To launch the feature select Display Wallboard from the File menu:

(Polling must have been started for this option to be accessible.)
You may use additional and separate Wallboards to monitor different groups or teams if you wish – simply
install the Managers Console on further machines and configure as usual. Alternatively, you can monitor
additional teams by setting up independent and separate instances of the Managers Console on the same
machine - as detailed in the section entitled ‘Multiple instances of the console’.
It is also possible to use two visual interfaces of the same Managers Console on one PC. i.e. one interface
for the Wallboard and another interface for the regular console view – although you might perhaps wish to
spread the two interfaces across a dual monitor system. For this purpose you can simply launch the
Managers Console a second time without exiting the first.

continued . . .

69

Allow a few seconds for the display to acquire the initial data:….

Automatic data sorting
The data in each column will be sorted automatically into sequential order.
The agent with the highest figure in each category will move to the top of that particular column,
immediately followed by the next highest, and so on.
The default refresh rate of the data is sixty seconds.
The columns indicate the following information:
Contacts - This is the total number of calls which resulted in an actual contact (i.e. calls which were
actually answered at either end - as opposed to inbound calls to voicemail, missed calls, outbound
unanswered or aborted calls etc.)
Outgoing - This is the total number of outgoing calls which were answered.
Incoming - This is the total number of incoming calls which were answered.
Duration - This is the total duration of calls which were answered.
Closing the Wallboard by clicking on the windows close button in the top right corner will cause the display
to revert to the original Managers Console interface.
Although if you wish, and if perhaps you have two separate monitors, you could display the two different
interfaces simultaneously by simply launching an additional instance of the Managers Console.
continued . . .
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Various colour options can be configured for the individual column backgrounds in order to clearly
distinguish the different call criteria. This can be a helpful contrast for agents who may be viewing at a
distance.

The available colours are as follows:
Red
Lime
Yellow
Blue
Fuschia
Aqua
Clear
Black
Contact Papillon Technology for further information.
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Historic Wallboard
The Historic Wallboard provides the same statistical elements as the ‘real-time’ Wallboard interface except
that it will produce a display based upon your choice of a particular period in history that you wish to
report upon.
The Managers Console is designed to display either the Wallboard or the Historical Wallboard at any one
time. If you wish to view and use both the real-time Wallboard and the Historic Wallboard simultaneously
you will need to start a second instance of the Managers Console and launch the respective wallboards from
each. (Or simply run a separate instance of the Managers Console on another machine when you wish to use
the Historic Wallboard without closing the real-time Wallboard.) If you need to monitor different agent
teams and to run a variety of wallboards and/or the regular console interface concurrently on the same
machine – refer to the section entitled ‘Multiple instances of the console’.
The real-time Wallboard uses call information from the currently active call logging session (which is
transient, and which relates to the current day only). However, the Historic Wallboard compiles data from
each users permanent call log (which maintains a constantly expanding history of calls).
Therefore you must have specifically enabled the ‘permanent call log’ option for the appropriate users.
This can be achieved from within the Managers Console as follows:
Select an agent by clicking on the radio button adjacent to the relevant agent name:

Then, from the Commands menu, toolbar icon
Settings:

or context menu, select Retrieve and Modify Agent
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Check Create External Call Logging File. Then click on the Apply button.
Repeat the above procedure if you wish to check or alter any other users settings.
NOTE The permanent call log must have been in existence during any period which you subsequently
wish the Historic Wallboard to report upon. You cannot report upon a period during which no permanent
call logging was enabled.
To launch the Historic Wallboard select it from the File menu –

NOTE
The Historic Wallboard option will not be
accessible unless polling is stopped.
(If polling is active then you have instructed
the Managers Console to operate in Realtime – and not in Historic time.)

73

This will display the following Configuration interface:

1.
Enter the relevant GoldMine® user names that you wish to report upon - just as they appear in the main
Managers Console interface. (In fact you can enter any name here, but it is likely that you wish to identify
agents by using their usual GoldMine® username.)
2.
Enter the full path to the respective users permanent call log file. By default this is named GMCALLS.LOG
and by default is located in the \Application Data or AppData\Roaming directory of the user’s C drive.
If the location is shared you can browse across the network to the file by clicking on the ellipsis button on
the right-hand side.
If the file is in the default location of the users C drive you can type the path as in the following examples:
\\computername\C$\Documents and Settings\user name\Application Data\gmcalls.log (XP®)
or
\\computername\C$\Users\Admin\AppData\Roaming\gmcalls.log (Win 7®)
COMPUTERNAME is the name of the relevant computer,
C$ is the hidden share to the C drive (substitute whichever drive letter if different. E.g. D$),
GMCALLS.LOG is the default name of the users call log file (unless specified differently in their
respective GMTAPI5.INI file.)
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3.
Enter the date range for the period you wish to report upon in the format DD/MM/YY or MM/DD/YY.
(The appropriate date format for your particular country will be recognized automatically.)
4.
If you wish to disregard any internal calls check the Report External Calls Only box.
5.
Click on the OK button.

A ‘static’ version of the wallboard will launch revealing a snapshot of the statistics for the chosen agents
during the period specified:
.
(Various colour options can be configured for the individual column backgrounds – contact Papillon
Technology for further information.)

To create a file in Comma Separated Values format, right-click and select

continued . . .
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Choose a suitable name for the file and its storage location -

Click on the Save button.
The file can be opened subsequently for viewing in a spreadsheet/word processor or other suitable
application –

- and can be sorted and manipulated, re-formatted and printed as required.
To return to the Managers Console interface simply close the Historic Wallboard window.
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Security Settings
This chapter has two sections
1. Concealing the agent’s setup options.
2. Removing the agent’s icon interface.
These options are designed to assist in preventing accidental alterations, and deterring deliberate
modifications, to any individual agent’s configuration settings. You may chose one or both if you wish.

1. Concealing the agent’s setup options
By default, individual agents will have access (via the context menu on the system tray icon) to the Setup
TL/PD for GoldMine® menu option as shown below. This feature permits each user to access and modify
their own individual configurations:

However, if you do not wish to permit user(s) to alter the Tapi Link / Power Dialer / Call Recorder
configuration settings, you can remove this particular menu option, (and therefore deny access to their
individual Setup configuration tabs) on a global or per-agent basis.

continued . . .
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To do so, proceed as follows:
Select the chosen agent in the Managers Console.
From the Commands or context menu select
Retrieve and Modify Agent Settings:

From the Setup Agent Configuration interface which appears, select the Advanced tab:

Check Hide Setup Screen from User. Then click on the Apply button.
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From the users’ perspective, their context menu will have altered in appearance as follows:
BEFORE

AFTER

The Setup option on the context menu is now concealed from the user.

2. Removing the agents icon interface
In order to remove the icon from the system tray, and effectively deny the agent access to the setup
configuration tabs AND the context-menu commands, proceed as follows:
Select the chosen agent in the Managers Console.
Then from the Commands or context menu select
Retrieve and Modify Agent Settings:

From the Setup Agent Configuration interface which appears, select the Advanced tab:
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Select the field marked Hide Tapi Link Completely.
Click on the Apply button to implement the changes and to revert to the original Managers Console
interface.
From the users perspective the icon will disappear from the system tray with immediate effect.

Tapi Link/Power Dialer/Call Recorder will continue to function as usual but will not be accessible for
control or modification by the agent.
Bear in mind that implementing this option will prevent the relevant agent from using a significant number
of options including:
Manually Acquiring Call Lists.
Manually starting and stopping Call Recorder for GoldMine®
Accessing the Speed Dial options.
Viewing call statistics
Accessing the Auto Top-Up Call List option.
Accessing the Call Logging interface.
Note that screen-popping dialog boxes will also be disabled.

Restoring the system tray icon
In order to restore the icon to the system tray proceed as follows:
Uncheck the option Hide Tapi Link Completely and click the Apply button.
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Agent Config Screen
Power Dialer can be configured very comprehensively and in precise detail – either from the Managers
Console or locally by individual agents at their own machine. However, in certain circumstances you may
prefer to allow certain agents a quick and simple method to acquire calls and to be able to start the calling
sequence entirely on their own initiative, without them needing to understand the intricacies of GoldMine®
or Power Dialer.

For example you might wish to instruct agents (perhaps by using the Send Message option) to start making
scheduled calls which have a certain Reference and a certain Activity Code …… and then to simply leave
them to get on with the task.
In this case the agent(s) would launch and follow a simple step-by-step ‘wizard’ which walks them through
the call acquisition process and then starts Power Dialer for them, using the specific References and Activity
Code criteria that you have just stipulated.
Implementing this process is achieved as follows:
From the Managers Console select the individual agent.

or the Commands
From the toolbar icon
menu, or context menu ….

select Retrieve and Modify Agent Settings
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From the Setup Agent Configuration interface which appears, select the Advanced tab:

Check Use Power Dialer Agent Config Screen and then click on the Apply button to implement the
change and to close the window.

From the agents’ perspective, when they right-click on the Power Dialer icon in their system tray:

continued . . .
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and Setup TL/PD for GoldMine® is selected –

- instead of the customary Setup dialog box, the following Agent Config Screen will appear:

This is the simple ‘wizard’ style of interface which guides the user, step by step, through acquiring their
Call List - right through to making the first call.
(This method, whilst being a very straightforward and rapid means of acquiring calls [perhaps for the less
experienced agents] can only work with pre-existing scheduled calls. In contrast, the default access to the
full compliment of Power Dialer features enables greater freedom of choice in terms of call acquisition
criteria.)
continued . . .
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The agent should follow the numbered sequence of items from 1 to 7 as follows:
Step 1
Advises the agent to log into GoldMine® and to ensure that they are working in the appropriate database.
Step 2
Requests that the agent clicks on the Get Info button (which checks that Power Dialer has the correct userinformation and GoldMine® settings in order to obtain the call data it requires.)
Step 3
Requests the GoldMine® Reference, if any, for the required calls. (This may either be typed or selected from
the drop-down list.)
Step 4
Requests the GoldMine®= Activity Code, if any, for the required calls. (This may either be typed or selected
from the drop-down list.)
Step 5
If the agent wishes to automatically acquire additional calls before they reach the end of their Call Queue they should click on the Auto Top-up button
Step 6
The agent should click on the Acquire List button to load their Call List.
Step 7
If the agent is ready to make calls they should click on the Start Dialer button.
The dialog box will be dismissed and Power Dialer will proceed to make the first call.
It will continue through the Call List until it is either suspended, or until the Call List is exhausted.
A dialog box will appear on screen to advise the user when the Call List has been completed.
To suspend the process, select Stop Power Dialer from the icon in the system tray. This action will not
terminate any current call in progress. It simply ends the ongoing sequence and prevents the next call and
subsequent calls in the Call List from being made. To resume, select Start Power Dialer.
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Create Agent Config File
In certain circumstances you may wish to prepare a specific configuration, in advance, for one or more Tapi
Link / Power Dialer / Call Recorder agents. This would serve as a ‘ready-made template’ of campaign or
Call List settings which can subsequently be ‘pushed’ to any or all of the respective agents.
These templates or campaign profiles are called ‘Config Files’ and they can be prepared and stored in
several different varieties in advance, and implemented whenever required.
Using this feature, you can for example, distribute appropriate settings when switching campaigns, reassign
relevant scripts, apply special security settings, or set up suitable calling profiles for new staff members.
As an example, a typical scenario might be as follows –
To prepare the setup for several new agents to use Power Dialer for a new campaign Using specific scheduled calls and automatic re-scheduling,
With a special script to be assigned for trainee staff,
With automatic recording and linking of a percentage of calls for quality control purposes.
Having pre-defined this particular criteria in a Config File, this file can then be deployed at any later time or
opened and used as a base for further modification to suit an entirely different campaign - and then saved
(using another filename) in a Config File ‘templates’ folder.
Using this method you can also deploy various different Config Files simultaneously to differing sets of
agents.
To create a Config File select Create Config File from the File menu:

(It is not necessary to have started polling before using this feature.)
Just as when preparing any letter or email template, the initial settings will be mainly blank, or basic, default
settings. If you prefer to start with an existing campaign template which might require only minor adaption
in order to become suitable for a different campaign - you may wish to refer instead to the section entitled
‘Create Config File from Agent’.
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Select the appropriate tab upon which you wish to start entering details. The following is simply a general
example. Right-clicking in a data field will raise a context menu requesting confirmation whether to add the
specific individual entry to the Config File, or to add the entire page of entries to the Config File. (In this
context ‘Page’ refers to the whole tab.)

Any changes you make are acknowledged by the text of the field label altering from black to red.

continued . . .
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Continue to add or modify settings in as many areas as you wish, as in the following example
(Or click on the Cancel button to abort entirely and to return to the Managers Console interface.)

To revise any errors or alter individual entries, right-click and select ‘Remove “…………..” Setting’
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When you are ready to save the Config File click on the Apply button.

Create or select a suitable location and designate a suitable filename for the Config File, and then click on
Save. If you plan to use a number of campaign templates such as this, it would be wise to use elaborate
names to describe exactly what each particular template does and for which campaign it is designed.
You may return and modify the Config File at any time. You may also simply re-open it for editing and then
save the incremental changes to yet another template under a different filename. (For further details see the
section entitled ‘Open Agent Config File’.)
88

Open Agent Config File
If you wish to view or edit an existing Config File, or you wish to adapt it for use as the basis for another
‘campaign template’ - proceed as follows:
Select File from the Managers Console menu bar:

Select Open Agent Config File.

Browse to the storage location of your Agent Config Files and select the relevant file:

Click on Open.
The Agent Config File will open within the Managers Console application and will reveal all of the predefined settings stored in that particular template, as in the following example:
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You may view or edit any of the existing settings.
If you wish to commit any changes you must right-click on a field label and choose to Add the settings.
Any changes you make are acknowledged by the text of the field label altering from black to red.
Then click the Apply button.
If you do so, you will be given the opportunity to either Overwrite the original existing file – (which will replace the original template with your new settings)
or alternatively to
Save the revised configuration under a new and separate filename – (which will safely retain the original
template, but also create a new one, which is adapted from the original and incorporates your
modifications.)
If you make no changes, both the Apply and Cancel buttons will have the same effect of dismissing the
dialog box without any alterations having been saved.
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In the above example, if you use the same filename you will be prompted to choose whether you wish to
overwrite the existing file as follows:

If you do not wish to do so, click on No, then amend the filename or type a new one.
If you wish to overwrite the existing file click on Yes.

Click on the Save button.
In the above example, a third Config File ( named ‘Latest Agent Configuration’) is being created having
used the safely preserved original file (‘Basic sales configuration’) as the initial basis for the revision.
Refer to the sections entitled ‘Send Config File to Agent’ and ‘‘Send Config File to All Agents’ if you wish
to deploy one or more of these files.
Note:
It is not necessary to have started polling before using the Open Agent Config feature.
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Create Agent Config File from Agent
In order to save time (and perhaps also to avoid possible errors) - rather than creating a completely new
Config File entirely from scratch, it is possible to use an existing agents’ settings - and then simply modify
some of those elements in order to create a completely new and separate ‘campaign template’.
Note that this process does not alter or disturb the existing agents’ settings in any way. It simply copies their
settings into a separate and brand new template which you are then at liberty to manipulate and to save for
other purposes.

To do so, proceed as follows:
From the Managers Console select the individual agent whose configuration settings you wish to use as a
basis for creating a new Config File, for example.

From the toolbar icon

or the Commands menu, or context menu ….

Select Create Agent Config File From Agent

continued . . .
92

The dialog box which appears will display the current settings of the selected agent -

Make whatever alterations are necessary on any of the tabs and then right-click to confirm either each
individual setting or the entire tab settings -
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Any changes made are acknowledged by the appearance of red text on the field label –

When all of the desired changes have been made click on the Apply button.
This will raise the dialog box in which you specify the name and location for the saved Config File.

Type a descriptive name for the file and click on the Save button.
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Send Config File to Agent
If you wish to deploy some pre-prepared configuration settings to a single agent, proceed as follows:
Firstly, select the relevant agent in the Managers
Console.
Then, from the Commands menu, context menu,
or via the toolbar icon
select Send Config File to Agent

Select one specific file of settings which you wish to apply to the agent:

Click on the Open button and the relevant agents configuration will be altered to incorporate the settings
contained within the chosen Agent Config File.
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Send Config File to All Agents
To distribute a pre-prepared set of configuration settings to ALL agents, proceed as follows:
From the Commands menu select All Agents > Send Config File to All Agents:

Select the location of your stored Agent Config Files:

Select the specific Agent Config File that contains the settings that you wish to impose upon ALL agents
and select Open.
In effect the configuration for ALL agents will be altered to incorporate the settings contained within the
chosen Agent Config File. (Bear in mind that commands pertaining to ALL agents apply only to all agents monitored
by this particular instance of the Managers Console, and not to different agents monitored by other instances of the
Managers Console which may be in use on the same machine, or elsewhere on the network.)
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Multiple instances of the console
The Managers Console displays up to fifteen machines to be managed.
In the event of a requirement to monitor a greater number of machines from one particular PC you would
simply need to run additional instances of the Managers Console.
You can also run other instances of the Managers Console on separate machines, but you may possibly
want to arrange that any single agent is only monitored from one machine – and only on one instance of the
Managers Console – in order to avoid any possible clashes of commands, or contradictory instructions from
the two separate instances.

The following information provides the necessary details if you propose to launch more than one instance of
the Managers Console on the same single machine –
It is NOT necessary to adopt this procedure if you simply wish to run an additional instance of the
Managers Console on a separate machine. In that event you would simply install the software as usual on
that other machine.
continued . . .
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In order to preserve separate and distinct information about different groups of agents for each instance of
the Managers Console, it is necessary to prepare –
(a) separately configured shortcuts from which to launch each of those instances, and
(b) separate configuration files (mancons.ini) to retain that information.
In order to do so, proceed as follows:
Firstly, create a copy of the shortcut from which the original Managers Console is launched as follows –
1. Right-click on the original Managers Console icon on the desktop OR in the Programs menu

2.
Select Copy from the context-menu:

3.
Right-click on an empty area of the desktop and
select Paste from the context-menu:
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4. This will create a copy of the shortcut as
shown below:

5. Right-click on the copied icon and
select Rename in order to rename it to
something more relevant to your purposes:

6. In this case the second shortcut has been
designated as ‘Managers Console 2’.

(If you wish you can also select a different
icon to represent the second shortcut. This
is achieved by right-clicking on the icon
and selecting Properties, then select the
Change Icon button on the Shortcut tab.)
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7. Browse to the directory in which the Managers Console is installed.
By default, it is in the. C:\Program Files…..\Papillon Technology\Managers Console directory.

Select the file named
Mancons.ini

8. Right-click on the
file and select Copy
from the context
menu:

9. Right-click in an
empty area of the
same window …..

and then select Paste
from the context
menu:
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10. This will
create a copy of the
Mancons.ini file in
the same directory

Right-click on
copied file and
select Rename
from the context
menu.
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11. Rename the file with the new name Mancons2.ini as shown in the following example:

This file will ultimately hold the configuration settings relating to the second instance of Managers Console.
Close the Managers Console directory window.

12. Now return to the desktop shortcut to the
Managers Console program that you created
earlier:

Right-click on the shortcut and select Properties
from the context menu:
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13. Select the Shortcut tab, then select the Target field:

At the end of the text “C:\Program Files\Papillon Technology\Managers Console\mancons.exe” leave a
single space and then type
“C:\Program Files\Papillon Technology\Managers Console\Mancons2.ini”
(Ensure that you place the quotation marks around the text.)
Note:
The path shown above is simply a typical example. The actual paths on your own system may vary.
If so, you will need to adapt the text entry accordingly.
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14.

Ensure that you leave a single space before the appended entry, and include the quotation marks as shown
above.
Although not all of the text will be visible in the Target field at once, the full text in the Target field should
now read exactly as follows:
“C:\Program Files\Papillon Technology\Managers Console\mancons.exe” “C:\Program Files\Papillon
Technology\Managers Console\ Mancons2.ini”
Once complete click on the OK button.
The effect of the above procedure is to inform the operating system to use a second, separate instance of the
Managers Console, also to use the second, separate configuration file (i.e. MansCons2.ini) that you have
just created.
If you wish you can use the above procedure again to create more instances of the Managers Console.
Simply ensure that you create different shortcuts, and additional ‘ini' files with different filenames on each
occasion.
Note
In fact, you may choose any filename that you wish, but the file extension must be .INI and you must use
that specific filename in the dialog box above.
continued . . .
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You may also add the additional shortcuts to the GoldMine® taskbar as detailed in the section entitled
‘Launching the Managers Console from within GoldMine®’.
However, in this case the command line C:\Program Files\Papillon Technology\Managers
Console\Mancons2.ini must be entered instead in the Command Line field as show below:

(Browse to a different location if you
wish to choose another icon to
represent the shortcut to the additional
instance of the Managers Console.)

The end result should appear similar to these example taskbars depicted here in
recent and earlier versions of GoldMine®.
For further details see the later section entitled ‘Launching the Managers Console
from within GoldMine®’.
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The Tools Menu
The Managers Console can call upon the features of optional additional tools if you have the relevant
licensed software installed on the local machine.

Select Tools from the Manager Console menu bar to access these features.
(It is not necessary to have started polling before using any of the tools featured.)
There are certain conditions relating to the use of these tools which are as follows:
FULLY OPERATIONAL TOOLS WHICH ARE INCLUDED
WITH THE CONSOLE Launch Call Logging Report
Convert External Call Logging File to DBF
Refresh dB Fast Lookup Table

THE FOLLOWING TOOLS ARE OPTIONAL EXTRAS
AND AVAILABLE UNDER SEPARATE LICENCE.
Phone Number Manager
Call Reallocator
Linked Documents Manager
These should be installed in the Managers Console directory on the same machine
that the Managers Console is installed. (By default normally C:\Program
Files…..\Papillon Technology\Managers Console\ on recent installations.)

Each of the above tools are detailed in separate sections in the following pages. 106

Launch Call Logging Report

This command will enable you to browse to the location of the call logging report that you wish to launch
for viewing or editing.
This report can be in a sophisticated format such as a Crystal Report® (if you have the associated application
itself installed on the same machine that the Managers Console is running upon), or alternatively a
‘Compiled Report Executable’ format (a self-contained and ‘self-running’ report executable) if you do not.
Alternatively you can view files such as GMAGENT.LOG or GMCALLS.LOG etc. in a simple text file
format. (By default, call logs relating to Tapi Link and Power Dialer for GoldMine® are created and stored,
depending on the windows operating system version, in the relevant users \Application Data or \AppData
directory on whichever machine you are currently dealing with.)
From the dialog box, click on the Files of type down arrow to select your choice of format:
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If you chose the ‘Crystal Report’ option:

and you have Crystal Reports installed, select the location of the file named GMCALLS.RPT or
GMAGENT.RPT and then select Open. The file will open in that application.
If you choose the ‘Compiled Report Executable’ option:

Select the location of the file named GMCALLS .EXE or GMAGENT.EXE and then select Open.
(GMCALLS.EXE originally exists only as a blank template. It is populated by choosing the command
Convert External Call Logging File to DBF and then selecting the relevant Call Log for conversion.)
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This will launch the following report configuration window:

Choose the required
parameters and click on
Print.

The appropriate Call Logging Report is launched:

109

Convert External Call Logging File to DBF
File conversions can be achieved on the local machine and also upon remote agent’s machines.
Click on Convert External Call Logging File to DBF:

This will permit you to browse to the location of the file that you wish to convert.
(By default, call logs relating to Tapi Link and Power Dialer for GoldMine® are created and stored,
depending on the windows operating system version, in the relevant users \Application Data\ or
\AppData\Roaming\ directory on whichever machine you are currently dealing with.)

Locate the GMCALLS.LOG and click on Open.
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If a similar table already exists in the same location, the following dialog box will appear:

If you wish to overwrite it click Yes, if you wish to append the new data to it click No.
A confirmation dialog box will appear:

Select Yes to delete, or No to keep any pre-existing GMCALLS.LOG file.
Confirm whether you wish to launch a Crystal Report:

Click Yes if you have Crystal Reports installed and you wish to launch the file directly within Crystal
Reports, or you wish to create a ‘self-contained report’ which can also be launched on other machines which
do not have Crystal Reports installed.
If Crystal Reports is not installed click No to proceed.
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A file named GMCALLS.DBF will be created in the directory as shown in the following example.
This file can be opened and viewed in other suitable applications such as Microsoft Excel®, and can be
imported, for example, into GoldMine® reports.

The GMAGENT.LOG files can also be converted to DBF format using the same method - see the resulting
file named GMAGENT.DBF above.

Note:
‘GMAGENT.LOG’ is the default name for files which are created when viewing and saving an individual
agents call log remotely, via the Managers Console.
‘GMCALLS.LOG’ is the default name for individual GoldMine® users call logs which are created locally
on the users own machine.
It is customary to rename the files, often using the actual agent identity, in order to differentiate between the
various logs.
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Refresh dB Fast Lookup Table
This section is of no relevance to users of GoldMine® 7, 8, 9, 2013 or 2014.
It applies only to older GoldMine® versions 6.x or earlier.
This section only concerns users who are:
1.
Using an earlier dBase version of GoldMine® and NOT using GoldMine® with Microsoft® SQL Server.
AND
2.
Using a centralized, shared dBase Fast Lookup Table (NOT a locally held table on each user’s machine).
The dBase Fast Lookup facility provides optimized performance by the use of an external data table
maintained by Tapi Link for GoldMine®. This feature maximizes the speed at which contact record data is
searched and propagated to the Popup screen.
Settings exist within the Setup Tapi Link dialog box options in order to refresh the dBase Fast Lookup
table automatically when Tapi Link is started and/or at set intervals. However, this particular option
provides the additional facility of refreshing the table manually, on demand.

The select Refresh dB Fast Lookup Table from the Tools menu:

This command will refresh the dB Fast Lookup tables at the centrally shared location, i.e. the network path
to the shared file TapiLink.dbf, confirmed by the brief appearance of the following dialog box:

Further details of this process are available by consulting the Tapi Link for GoldMine® Configuration Guide
in the section entitled ‘Optimisation for dBase systems’
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Phone Number Manager
Effective use of screen-popping with GoldMine® requires good data management for existing and newlyinput data, and the updating of area codes to accommodate changes that take place from time to time.
This utility allows you to manage these changes to your GoldMine® databases with ease.
Area Code changes can be applied to telephone numbers which occur in the GoldMine® Phone 1, Phone 2,
Phone 3, and Fax number fields and also numbers which appear on the Additional Contacts tab. Phone
Number Manager is also fully ‘sync-aware’.
This product can also correct the USA/ International telephone format flag for all of your contact records,
and also re-format any improperly formatted telephone numbers.
Select Phone Number Manager from the Tools menu:

The first tab of the dialog box focuses upon the revision of area codes and the second on telephone number
formatting.
Both areas of functionality permit a ‘Dry Run’ feature which provides an indication of the extent of the
issues discovered - but without committing any actual changes to GoldMine®.
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Features of the Area Code Changes element:
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Features of the Telephone Number Formatting element:

This optional tool is available under separate licence and further details can be found at the following
location: http://www.papillontechnology.co.uk/Download/Utility.pdf or contact your GoldMine® Reseller
or Papillon Technology by telephone on 01992 560487 (+44 1992 560487) from the US on
+1 (408) 960 1032 or by email to sales@papillontechnology.com
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Call Reallocator
In a Call Centre environment managing complex GoldMine® call lists can be problematic, particularly if
large numbers of agents and multiple campaigns are involved. Call Reallocator allows system
administrators to dynamically assign and re-assign any number of calls from multiple campaigns to and
from different outbound call agents to accommodate changing campaign stages, changing work-shifts,
absent staff, skills variation and lead rotation. It is also perfect for drawing down calls from a general ‘pool’
of calls and distributing them to specific users.
Click on Call Reallocator in the Tools menu:

Simply choose the source user or pool, destination user, the number of calls you wish to move, optionally
filter by Reference and Activity Code, and then click Re-Allocate.
The desired number of calls matching the filter are immediately re-distributed to the selected user.
This optional tool is available under separate licence and further details can be found at the following
location: http://www.papillontechnology.co.uk/Download/Utility.pdf or contact your GoldMine® Reseller
or Papillon Technology by telephone on 01992 560487 (+44 1992 560487) from the US on +1 (408) 960
1032 or by email to sales@papillontechnology.com
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Linked Documents Manager
This tool is designed solely to function with older versions of GoldMine® (version 6 or earlier) – and not with
GoldMine® versions 7, 8, 9 2013 or 2014.

Linked Documents Manager allows administrators to move the storage location or to archive linked files
associated with GoldMine® and yet be able to easily update all of the relevant entries on the GoldMine®
Links tab to point to the new file locations.
If users have stored linked documents on their local hard drive, preventing access by other users, simply
move the files to a properly shared network location and then run the Linked Documents Manager to
quickly update all of the corresponding entries on the GoldMine® Links tab.
Linked Documents Manager can also remove links and/or the corresponding files themselves (for example
after archiving) and can seek out only the links and files that meet the exact criteria you specify (e.g. by
User, or Date, Document Name, Notes, etc.)
As well as dealing with standard document links it can also be used to maintain mailbox attachments,
history attachments and templates, and is ideal for the archiving or maintenance of Call Recordings.
Click on Linked Documents Manager in the Tools menu:

The first tab of the utility focuses upon the revision of incorrect paths within the entries on the Links tab and
the second tab on eradicating incorrect or unwanted links and/or corresponding target files.

Both areas of functionality permit a ‘dry run’ feature which provides an indication of the extent of the
problems discovered - but without committing any changes to GoldMine®.
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The progress monitor indicates the ongoing processing, along with the total entries that have been examined
and dealt with.
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Link deletions and the corresponding file deletions can be made either separately or simultaneously.

This optional tool is available under separate licence and further details can be found at the following
location: http://www.papillontechnology.co.uk/Download/Utility.pdf or contact your GoldMine® Reseller
or Papillon Technology by telephone on 01992 560487 (+44 1992 560487) from the US on +1 (408) 960
1032 or email to sales@papillontechnology.com
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Launching the Managers Console from within GoldMine

®

If you would prefer to have a shortcut to launch the Managers Console directly from within the GoldMine®
interface as follows –

Right-click and select Customize Taskbar -

The Taskbar Group Item Selection box will appear:

Click on the drop-down
list box arrow to reveal the
available Item Type
options.

Then select External
Application from the
drop-down list.

121

In the Caption field of the Taskbar Group Item Selection box type ‘Managers Console’

To the right of the Application field, click on the ellipsis button to browse for the application you wish to
use. In this case, the Managers Console program.
This will raise a dialog box similar to the following:
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Navigate to the files stored in the Managers Console directory.
(If you installed the Managers Console to the default location, this will be a sub-folder of the Program Files
directory. e.g. C:\Program Files\Papillon Technology\Managers Console. Or C:\Program Files (x86)\
Papillon Technology\Managers Console.)
Browse for the file named mancons.exe as indicated above.
Highlight the file and click on the Open button shown .
This will return you to the Taskbar Group Item Selection dialog box; populated with the relevant
information as shown earlier. (The actual paths shown may appear differently on your own machine):
Click on the OK button to complete the process.
You may also add shortcuts to additional instances of the Managers Console to the taskbar if you intend to
monitor more than 15 users – see the earlier section entitled ‘Multiple instances of the console’.

Earlier versions of GoldMine

®

If the GoldMine taskbar is not
already visible select Window
from the GoldMine menu bar.
®

®

Then select Taskbar.

This illustration depicts a new and empty taskbar - your own version
may already have one or more existing icons.
(After completing the following procedure you may remove or alter
the order of any of the icons to suit your requirements.)

Right-click within the taskbar and select Add New Item from the
context-menu:
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Alternative methods of machine identification
When you first run the Managers Console you will need to enter either the machine names or the IP
addresses of the machines which you wish to manage. These client machines will need to have at least one
of the following applications installed:
Tapi Link for GoldMine®
Power Dialer for GoldMine®
Call Recorder for GoldMine®
Enter the DNS names or the IP Addresses in the fields indicated below:

Note that the very first field in the column is pre-populated with the IP Address of the machine upon which
the Managers Console has been installed. However, this machine does not necessarily need to be included in
the group of machines that are monitored. (Indeed, it may not necessarily have Tapi Link/Power Dialer/Call
Recorder installed.) So this entry can be deleted if you wish and the field can be allocated to another
machine.
You can establish the names or addresses of the computers that you wish to manage by a number of means.
The chosen method may also depend upon the operating system in use at each machine.
Continue through the various options which follow until you find the most appropriate for your needs.

continued . . .
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For example in Windows 7 select Start > Control Panel > System.
The computer name is shown at the end of the basic information as follows –
®

Or, within a Windows XP or similar operating
system, right- click on the My Computer icon on
the desktop and select Properties:
®

continued . . .
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Select the Computer Name tab

The field marked Full Computer Name displays the machine name.
(Do NOT use the ‘Computer description’.)
If the entry shows a name similar to the following format:
Machinename. Other name. com
Simply use the first part of the name i.e. Machinename not the trailing domain names or the punctuation.

continued . . .
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Alternatively, to establish computer names on your network using another method:

From the desktop, select the My Network Places
icon (or Network Neighborhood in earlier
Windows versions.)

Double-click on Entire
Network.

Double-click on Microsoft
Windows Network
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Select your domain.

The computer names of
your domain or
workgroup should now
be listed. Make an
accurate note of the
names of all machines
which have Tapi
Link/Power Dialer/Call
Recorder for GoldMine®
installed.

(As another alternative, more experienced users may wish to use IPCONFIG via the command line in order
to obtain IP Addresses of various individual machines, and the command NET VIEW provides a list of
computer names on the network. If you are not familiar with the windows command line interface and
require further assistance with these commands – see your system administrator.)
Once you have established the names of the machines you wish to manage – enter them in the DNS Name/
IP Address column of the Managers Console
You may enter the identities of the machines by IP Address only, by DNS Name only, or by a mixture of the
two.
If you need to monitor more than fifteen machines - see the section entitled ‘Multiple instances of the
console’.
(Note. It is not possible to add or amend details in the DNS Name / IP Address field whilst the Managers
Console is polling for machines. If you are unable to revise or add any details, click on the Stop Polling
button first.)
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Frequently Asked Questions (FAQs)
One or more of the agents’ machines remains represented by a butterfly instead of a telephone icon.
Check that Tapi Link/Power Dialer/Call Recorder for GoldMine® is actually installed and running on the
relevant machine(s). Also check that the machine name or IP address is correctly specified. Click on Stop
Polling and then click on Start Polling again in order to refresh the display. Check that the agent machine
is properly connected to the network. Right-click on the username and select Retry Polling. If problems
persist use the IP addresses of the machines rather than the DNS names.
An agents Call Count appears high, although the Q Position seems to be disproportionately low.
The agents configuration includes Dial Alternate Numbers if Call is Unsuccessful, so more calls are being
made than the total number of single line entries in the Call Queue.
The call statistics or the call logs do not seem to show the expected quantities of calls.
Within the Historic Wallboard - check whether you have selected Report External Calls Only.
Within the Managers Console status bar - ‘Answered’ refers only to calls that are actually connected.
Within the main Managers Console interface - The Call Count shown in the main console interface is the
total of attempted calls rather than simply the number of connected calls. Many calls may have been
unanswered, and some outbound calls may have been abandoned in favour of answering an inbound call
instead. Calls which have gone to voice mail, busy line numbers, unanswered calls, and bad numbers are
considered to be unanswered calls.
Selecting Retrieve and Modify Agent Settings has no effect – nothing seems to happen.
This particular option has been locked-out temporarily. The agent may currently be in the middle of an
operation that is best not interrupted, for example, acquiring a Call List. Try again in a few moments.
I cannot see all of the usual agents Setup tabs when viewing remotely from the Managers Console Setup
Agent Configuration screen.
The remote interface is not the actual agents dialog box itself, but a representation of the view that the
individual agent would have of their own Setup dialog box. If your monitor is set to an unusual resolution
you may need to adjust the dialog box to extend/enlarge it by dragging the perimeter(s) to suit. The only tab
that is not present in the Setup Agent Configuration screen is the users TAPI tab and the PD Call Queue
tab. However, there are extra tabs (e.g. Speed Buttons) which are only visible from within the Managers
Console interface, and similarly, additional options are available on certain tabs (e.g. Advanced).
It seems impossible to amend details or to add text to any of the DNS Name / IP Address fields.
It is not possible to add or amend details in the DNS Name / IP Address field whilst the Managers Console
is polling for machines. If you are unable to revise any details, click on the Stop Polling button first.
It is not possible to use the Refresh dB Fast Lookup Table option from the Tools menu.
Firstly, this particular feature is only relevant to users of Tapi Link for GoldMine® - not Power Dialer or Call
Recorder for GoldMine® users. Secondly, if you are using any version of GoldMine®later than 6.x or in
conjunction with Microsoft SQL Server, then this particular feature is of no relevance and is not required.
If, however, you are using a dBase version of GoldMine® ensure that you have screen-popping enabled (via
the Calls In tab), a correct and validated dBase Fast Lookup activation key (see the Application Log for
details), and have enabled ‘dBase Fast Lookup’ (via the Searching tab) of Tapi Link for GoldMine® Setup
dialog box.
®
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It is not possible to use one or more of the following items from the Tools menu - Call Reallocator / Phone
Number Manager / Linked Document Manager.
These additional tools are optional ‘plug-ins’ to the functionality of the Managers Console. Each of these
additional tools are extra features available under separate licence. They should be installed in the Tapi Link
directory (normally C:\Program Files\Papillon Technology\Tapi Link by default) on the same machine that
the Managers Console is installed. Contact Papillon Technology for further details.
It is not possible to use the Start Recording Call option from the Commands menu.
Call Recorder GoldMine® is an optional extra and not part of the default functionality of Tapi Link / Power
Dialer. Please contact Papillon Technology for further details of this feature.
A message sent to all users (or some other command) has not been transmitted to all agents.
You may be running more than one instance of the Managers Console in order to accommodate additional
agents. Commands issued from one instance of the Managers Console will not be propagated to agents
managed exclusively by another instance.
The Force ALL Agents to Exit command fails to work for all agents.
See the previous answer above.
Although logged in and active, no activity is shown for one or more agents in the Managers Console.
If the agent launches a session of Tapi Link or Power Dialer for GoldMine® after you have already started
polling - you will need to click on Stop Polling and then Start Polling once again to include the new
agents. Alternatively, right-click on the individual agent concerned and select Retry Polling.
However, you do not need to use the above methods if you have enabled Auto Retry Connect to Clients in
the Preferences options.
The entries under the Commands menu are ‘greyed-out’ and inaccessible.
You need to click on the Start Polling button before you can access any menu commands.
Having clicked on the Apply button and selected Save, an Agent Config File does not appear to be created.
You must right-click on at least one of the fields with the Setup Agent Configuration dialog box and chose
to ‘Add’ or ‘Remove’ an individual entry, or alternatively select ‘Add all settings on this page’, and then
the committed changes will be confirmed by the text on the field labels changing color from black to red.
Subsequently you may click on the Apply button to dismiss the setup interface.
There are a considerable number of individual machines on the network which have to be identified before I
can start polling. Is there a quicker method of establishing the DNS names of all the machines from one
single location?
From a command line prompt type NET VIEW, or refer to the section entitled ‘Determining the machines to
be managed’.
Having selected an agent and then chosen Start Recording Call followed by Stop Recording Call – when
attempting to replay the relevant file there is no recorded sound.
It is likely that an agent who was not currently engaged in a call was inadvertently selected. The recording
command is still executed even if there is no audio element to be recorded. However, if the correct agent
was selected, the call recording hardware may not be correctly connected or the recording/playback levels
may need adjustment.
continued . . . .
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The icon status indicates that Tapi Link or Power Dialer is running but no username is displayed.
GoldMine® is not currently running on the relevant machine.
Some commands e.g. Auto Top-Up to Call List, Acquire New Call List, Start/Stop Power Dialer are
greyed-out and inaccessible.
If the particular agents do not have Power Dialer for GoldMine® installed on their machines these options
are irrelevant and consequently will not be available.
Is it safe to stop an agents Power Dialer without affecting the current call in progress?
Yes. This is the correct practice to either temporarily suspend or end a Power Dialer session. Selecting Stop
Power Dialer is the equivalent of stopping the progress of the power dialing sequence and will not
terminate the current call, but simply prevent the next call from being made.
The column Call Count seems to display more calls than were actually dealt with.
The Call Count will indicate all attempted calls, regardless of whether successfully connected or not. Refer
to the individual agents answered call statistics for an accurate record of successfully completed (connected)
calls.
There are no contact details shown against the agent’s current call.
Assuming this refers to an incoming call - screen-popping needs to be enabled for the appropriate agent.
Alternatively, if this relates to a manually dialed number (i.e. not dialed from within GoldMine®)
- then in order for the relevant contact record information to appear Reverse Search on Manual Outgoing
Call needs to be enabled on the Calls Out tab. (This of course assumes a contact record pertaining to the
dialed number actually exists.)
I do not appear to have a licence serial number for the Managers Console / Where is the licence serial
number entered?
No separate licence serial number is issued for the Managers Console therefore there is no means of input
for a licence serial number. The Managers Console uses the licence serial numbers of its clients. Simply
enter the activation key via the File > Licensing menu
The Historic Wallboard does not provide any data for the particular period or user specified.
The permanent call log for the relevant user(s) must have been enabled and active during any period which
you subsequently wish the Historic Wallboard to report upon. Check the option to Create External Call
Logging File on the Advanced tab.
The Historic Wallboard option in the File menu is greyed-out and inaccessible.
You are currently viewing real-time data but wish to display historic data. Click on Stop Polling before
attempting to open the Historic Wallboard.
Selecting Get All Versions from the Commands > All Agents menu seems to have no effect.
After selecting this option you need to hover the mouse cursor over the name of each or any agent.
When using the Speed Buttons, the relevant GoldMine® fields do not appear to update or populate with the
pre-determined data.
It is necessary for the same Speed Button(s) which you have programmed to update fields to also
incorporate a scheduled activity. Refer to the section entitled ‘Updating Fields Automatically’.
continued . . . .
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Call Statistics seem to be incorrect/excessive, or seem to include yesterday’s calls.
The previous user session has not been ended. i.e. The last working session has not been concluded and
therefore the session and statistics are considered to be continuous. This is usually evident in circumstances
where the agent has not logged out of Windows. Simply exit and restart Tapi Link/Power Dialer to start a
new session. (This approach is necessary because working periods are not viewed in ‘calendar-style’ 24
hour daily sessions. If they were, then for example, if an agent commenced at 9pm and ended the Power
Dialer session at 3am, then the statistics would only cover the last 3 hour period rather than the full six hour
session.)
Certain elements or features seem to be missing from the software.
Contact Papillon Technology for an updated version. See the section entitled ‘Contacting Technical
Support’.
The Preferences option is greyed-out and inaccessible.
Click on Stop Polling in order to access the Preferences option.
The Find Current Contact Feature is not functioning.
Enable screen-popping for the specified user(s).
Certain agents appear on the interface later than others.
The relevant agents are only just logging in or have only just launched Tapi Link/Power Dialer.
No files are found when browsing for the Config Files – either when selecting File > Open Agent Config
File or Send Config File to Agent.
Either you are browsing to an incorrect location or you have not correctly implemented the proper
configuration and saving of the files. Refer again to the relevant sections and ensure that when entering any
settings that the field names alter from black to red text before you click on the Apply button. Unless the
text turns red you are not actually saving any changes and therefore not saving any file either.
I need more elaborate technical information in order to take full advantage of the Manually Change Agents
Settings options.
Contact Papillon Technology for further details. (See the later section entitled Contacting Technical
Support.)
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Troubleshooting connection issues
Refer to the previous ‘FAQs’ section for a wider coverage of issues with the Managers Console.
In the event that one or more of the agents are not visible in the Managers Console (i.e. the butterfly icon
does not alter to a telephone icon) as in the following example:

Right-click on the relevant agent PC and select Retry Polling.
If, after a few moments there is still no apparent connection with the relevant agent, select Stop Polling
from the File menu:

Then, select Start Polling once again. If this proves
unsuccessful, exit and restart the Managers Console.

continued , , , ,
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If the symptoms persist, proceed as follows:
Check that Tapi Link / Power Dialer / Call Recorder is actually installed and running on the relevant agent
machine(s).
Check that you are using the correct format for the computer names or IP addresses as entered in the
Managers Console.
Check that windows Firewall is not preventing satisfactory communication between the respective
machines. Check the specific agents machine and also the machine upon which the Managers Console is
running. Disable the Firewalls(s) and test by selecting Start Polling again. Check similarly that no third
party firewall or security program preventing satisfactory communication between the respective machines.
If one agent is correctly depicted with a telephone icon – copy that particular agents DNS name or IP
Address into the very topmost slot in the Managers Console and then select Start Polling again.
If you have a third-party network security program, anti-virus application, or anti-malware software
installed – temporarily disable it and check that it is not preventing adequate communication between
machines.
Use the PING command to confirm whether communication can be made with the relevant machines.
If only one or two agents appear with butterfly icons instead of a telephone icon, but others are correctly
represented by telephone icons – reboot just those machines before selecting Start Polling again.
If all agents machines remain depicted by butterfly icons instead of a telephone icon – reboot the Managers
Console machine before selecting Start Polling again.
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Contacting Technical Support
Should you experience any difficulties with this product - you are strongly urged in the first instance to
consult the contents of this user guide, and in particular the sections entitled ‘Frequently Asked Questions
(FAQs)’and ‘Troubleshooting’.
However, if you are unable to resolve a particular problem and subsequently find it necessary to contact
Papillon Technology for further assistance, the swiftest resolution to any problem you may encounter with
this product will be achieved if you ensure that you have the following information at hand before
contacting us:
A. The version number of your GoldMine® software. (This can be obtained by accessing the Help
menu in GoldMine® and selecting the About item.)
B. The version number of your Managers Console software. (This can be obtained by selecting Help
from the Managers Console menu bar and then selecting About from the context menu.) For
example:

Requests for technical support from Papillon Technology relating to this product can be achieved by the
following means:
Via Email

support@papillontechnology.com

By Telephone

+44 (0)1992 560487 or from the US on +1 (408) 960 1032

Our Web site :

http://www.papillontechnology.com
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Legal Information
No liability for consequential damages. In no event shall Papillon Technology or its suppliers be liable for any indirect, consequential,
special or punitive damages whatsoever (including without limitation, damages for loss of business profits, business interruption, loss
of business information, or any other pecuniary loss) arising out of the use of or inability to use this Papillon Technology product, even
if Papillon Technology has been advised of the possibility of such damages. Because some
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation
may not apply to you.
Papillon Technology’s entire liability and your exclusive remedy shall not exceed the price paid for the software.

Windows®, Windows 98®, Windows NT®, Windows 2000®, Windows XP®, Windows Vista®, Windows 7®, Windows 8® and Windows
10® are registered trademarks or trademarks of Microsoft Corporation in the U.S.A. and/or other countries. The names of actual
companies and products mentioned herein may be the trademarks of their respective owners. The exampled names of companies,
products, people, characters and/or data mentioned herein are fictitious and are in no way intended to represent any real individual,
company, product or event, unless otherwise specifically stated.
Due to our policy of constant improvement and development Papillon Technology reserve the right to alter specifications without prior
notice. E & O E
© 1997-2016 Papillon Technology All rights reserved.
Any rights not expressly granted herein are reserved.
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